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1. INTRODUCTION 

The JUMP Workbench (see Figure 1-1 below) is a graphical user interface (GUI) that can 
be used to visualize and manipulate spatial datasets.  It exposes the functionality of the JCS 
Conflation Suite (including functions such as warping and conflation) and allows it to be 
applied to spatial datasets in a convenient and intuitive way.  
 
 

 
Figure 1-1 – The JUMP Workbench showing a map of Victoria BC 

 
 
The Workbench is designed for use in several different scenarios:  
 

• as a debugging, visualization, and QA tool for the development of conflation 
algorithms 

• as an interactive, easy-to-use tool to run conflation algorithms on datasets 
• as a general-purpose tool for visualizing and manipulating spatial datasets 

 
This document discusses how to use the features pertaining to: 
 

• the Workbench as a whole 
• tasks 
• layers 
• selection 
• features 
• spatial functions 
• warping 
• options 
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1.1 RELATED DOCUMENTS 
Related information is contained in the following documents: 
 
JCS User’s Guide Explains how to use the JCS Conflation Suite and the 

Workbench to clean and conflate datasets. 

JUMP Developer’s Guide Provides detailed information on extending the 
Workbench through its plug-in framework 

JCS Project Report Details the design approach and algorithms investigated 
during the JCS Conflation Suite project 
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2. THE WORKBENCH 

This section discusses the parts of the Workbench, the Undo/Redo facility, and how errors 
are reported to the user. 
 
 

2.1 WORKBENCH COMPONENTS 
The major components of the Workbench are depicted in Figure 2-1 below. 
 
 

 

Task 
Window 

Layer 
List 

Layer 
View 

HTML View 

Attribute 
View 

Output 
Window 

 

 
Figure 2-1 – Parts of the JUMP Workbench 

 
 
The Task Windows are the main windows.  Task Windows are named as such because 
they allow you to visually perform your conflation tasks.   
 
The definition of a task in JUMP is “a collection of layers that are used together in a 
conflation process”.  A layer is a dataset. 
 
A Task Window has two parts: a Layer List on the left, and a Layer View on the right.   
 
The Layer List shows the names of the layers in belonging to the task.  You can hide a 
layer by clearing the checkbox beside it.  To edit the name of a layer, simply double-click on 
it. 
 
The Layer View presents a graphical display of the data.  You will use the Layer View to 
select features, zoom in and out, analyze the shapes of features, and perform other visual 
activities. 
 
The Attribute View displays the attributes for features.  You can sort on an attribute by 
clicking on its column header.  The toolbar buttons on this window allow you to step through 
the layer, panning to each feature (see 6.1 Inspecting Features on page 28). 
 
The HTML View lets you view the coordinates of a feature, together with its attributes (see 
6.1 Inspecting Features on page 28). 
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Many Workbench processes write output to the Output Window.  You can open it by 
clicking on the View menu and choosing Output Window; or you can simply press  on the 
toolbar.  The record control  at its lower-left corner allows you to look back at 
previous output. 
 
Note: Some menu items will be disabled if they require further action on your part (e.g. 
selecting some layer names).  If you hold the cursor over a disabled menu item, it will 
display a tooltip describing what needs to be done. 
 
There are a number of folders, or categories, in the Layer List that you can use to organize 
your layers.  When you open a dataset, you can assign it to any category; however, you 
may want to follow the following semantics: 
 

• Working.  This is a general purpose category.  Use this category for layers that you 
want to experiment with.  When the Workbench generates layers, it usually puts 
them in this category. 

• Reference.  Conflation involves processing two or more input layers together to 
produce a result.  The input layers play two different roles in the conflation process.  
Typically one or more layers are reference layers – they are left unchanged.  You 
can put reference layers in the Reference category. 

• Subject.  The other kind of input layer involved in a conflation process is the 
subject layer – it is adjusted to match the reference layers (mentioned above).  You 
can put the subject layer in the Subject category. 

• Result-Reference.  This category contains layers generated by conflation processes 
and pertaining to reference layers. 

• Result-Subject.  This category contains layers generated by conflation processes 
and pertaining to the subject layer. 

• QA.  Quality assurance (validation) processes generate layers into this category. 
 
To put a dataset into a specific category, simply right-click on the category and choose Load 
Dataset from the pop-up menu (see 4.1 Loading A Layer on page 15). 
 
 

2.2 UNDO/REDO 
The Workbench’s Undo/Redo facility allows you to reverse an action which you have just 
performed.  
 
Undo/Redo has not yet been implemented for all actions; when it is not available, the  and 

 buttons will be disabled.  
 
 

2.3 ERROR HANDLING 
If the Workbench encounters a problem (for instance, if a file you are loading is corrupted), 
it will notify you with a dialog box (see Figure 2-2 below). The Show/Hide Details button will 
display the stack trace, which is useful for programmers tracking down the problem. 
 
 

Document converted by PDFMoto freeware version



Ministry Of Sustainable Resource Management JUMP Workbench User’s Guide 

 

 
5-Nov-2003 Page 10 

 

 
Figure 2-2 – The Error dialog 

 
 
Less serious problems (warnings) are displayed with a flashing yellow message in the status 
bar.  If the status bar is not long enough to display the entire message, you can hold the 
cursor over it to show a tooltip with the entire message.   
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3. TASKS 

A task is a collection of layers that are used together in a conflation process.  When you 
start the Workbench, there will be one task (without any layers) – you will see one Task 
Window (see 2.1 Workbench on page 8). 
 
This section describes task-related activities: 
 

• zooming 
• panning 
• creating a new task 
• opening a new window on a task 
• saving a task 

 
 

3.1 ZOOMING 
There are a number of ways to zoom in to or out of areas shown in the Layer View. 
 
Ñ To quickly zoom in or out 

• Drag the knob on the Zoom Bar ( ) to the left or right 
 
You can get a more detailed, resizable Zoom Bar by choosing Zoom Bar from the View 
menu. 
 
Ñ To zoom in to a specific point 

• Ensure that the Zoom Tool ( ) is pressed 
• Click on the point that you want to zoom in to 

 
Ñ To zoom out from a specific point 

— if the Zoom Tool ( ) is pressed — 
• Click on the point that you want to zoom out from 

— if  is not pressed — 
• Right-click on the point that you want to zoom out from and choose Zoom Out from 

the pop-up menu 
 
Tip: Regardless of which tool is pressed, you can always zoom in and out using [Alt] + Left 
Click and [Alt] + Right Click. For more shortcut keys, see 10 Appendix: Shortcut Keys on 
page 45. 

 
Ñ To draw a box to zoom to 

• Ensure that  is pressed  
• Drag a box to zoom to 

— or — 
• Ensure that the Fence Tool ( ) is pressed 
• Drag a box to create a fence 
• Right-click on the Layer View and choose Zoom To Fence from the pop-up menu; or 

press the Zoom To Fence button ( ) 
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Ñ To zoom to specific features 

• Use the Select Tool ( ) to select the feature(s) to zoom to (see 5.1 Selecting 
Features on page 24) 

• Right-click on the Layer View and choose Zoom To Selected Features from the pop-
up menu; or press the Zoom To Selected Features button ( ) 

 
You can also use the Attribute View’s  and  buttons to zoom and pan to each feature, 
one at a time.  For more information, see 6.1 Inspecting Features on page 28. 
 
Ñ To zoom out to the extent of a specific layer 

• Right-click on the name of the layer in the Layer List and choose Zoom To Layer 
from the pop-up menu 

 
Ñ To zoom out to the combined extent of all layers 

• On the toolbar, press the Zoom To Full Extent button ( ) on the toolbar 
 
Ñ To undo a zoom 

• Press the Zoom Prev button ( ) on the toolbar 
 
Ñ To redo a zoom 

• Press the Zoom Next ( ) button on the toolbar 
 
Note: If you keep zooming in, you may reach a point at which features appear to drift from 
their true locations, perhaps even disappearing from the Layer View altogether.  At this 
level of magnification, the resolution required is too great for the Workbench’s drawing 
system, and you should simply zoom out.  This limitation applies to extremely high 
magnifications only. 
 
 

3.2 PANNING 
You can pan around in the Layer View to bring other areas of the data into view. 
 
Ñ To see the data to the immediate left of the current view 

• Ensure that the Pan Tool ( ) is pressed 
• Drag on the Layer View from left to right 

 
Tip: Regardless of which tool is pressed, you can always pan using [Shift] + [Alt] + Drag. 
For more shortcut keys, see 10 Appendix: Shortcut Keys on page 45. 
 
Ñ To undo a pan 

• Press the Zoom Prev button ( ) on the toolbar 
 
Ñ To redo a pan 

• Press the Zoom Next ( ) button on the toolbar 
 
 

3.3 CREATING A NEW TASK 
Creating a new task is useful if you want to work with layers in a space separate from the 
current task. 
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Ñ To create a new task 

• From the File menu, choose New Task.  A task window will appear (see Figure 3-1 
below). 

 
 

 
Figure 3-1 – Window for a new task 

 
 

3.4 OPENING A NEW WINDOW ON A TASK 
Sometimes it is useful to have multiple windows on a task.  For instance, you could have 
one window showing an entire layer, and another window zoomed in to show a few features. 
 
Ñ To open a new window on a task 

• From the Window menu, choose Clone Window.  A new task window will appear 
(see Figure 3-2 below). 

 
 

 
Figure 3-2 – The original task window and a new task window 

 
 
The new task window is identical to the original task window, except that the Layer List is 
not shown.  To display the Layer List, drag the left edge of the window to the right by an 
inch or so. 
 
Zooming, panning, and selection on each window is independent.  However, the underlying 
layers are the same, so if you modify a feature in one window, the change will be reflected 
in the other window. 
 
Note: Opening a new window on a task is different from creating a new task (Section 3.3).  
In both, a new window is created.  However, in the former, the underlying datasets are the 
same, whereas in the latter, they are different. 
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3.5 SAVING A TASK 
Suppose you have a half dozen layers that you work with on a regular basis. It would be 
tedious to open each one separately every time you wanted to work with them. Plus, you 
wouldn’t want to set the colours and line widths every time you opened them. The 
Workbench allows you to save a collection of layers (i.e. a task) and their formatting details 
in a small XML file, which you can load in the future. 
 
Ñ To save a task to a file 

• If any of your layers have not yet been saved to a file, right-click each of them and 
choose Save Layer As (otherwise those layers will not be included in the project file 
below). (Future: automatically prompt the user to save new layers) 

• From the File menu, choose Save Project. You will be prompted to enter a name for 
the project file. (Future: rename Project to Task, or vice versa). 

 
Note: Save Project will not save the individual layer files, even if you’ve modified them. You 
still need to use Save Layer As on each layer. (Future: When the user clicks Save Project, 
display a list of layers that have changed, with checkboxes to indicate whether to save 
each). 
 
Ñ To load a task from a file 

• From the File menu, choose Open Project. You will be prompted to enter the name 
of the project file. 
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4. LAYERS 

A layer is a dataset, a collection of features; layers are named as such because as they are 
created, they are “layered” on top of one another. 
 
This section describes activities pertaining to layers: 
 

• loading a layer 
• saving a layer 
• changing layer styles 
• editing a layer schema 
• creating a blank layer 
• removing a layer 
• copying a layer 
• renaming a layer 

 
 

4.1 LOADING A LAYER 
The Workbench can create layers from the following types of files: 
 

• JUMP GML  
• GML 
• Well-Known Text 
• Shapefile 
• FME GML 

 
Tip: You can open zipped or gzipped files directly. 
 
The JUMP GML file format was developed for the JCS Conflation Suite project. JUMP GML 
does not need an input template (see below) to be opened in the Workbench. 
 
Ñ To open a JUMP GML file 

• From the File menu, choose Load Dataset.  A dialog will appear. 
• From the Format combobox, choose JUMP GML 
• Select the file you want to open 
• Press OK 

 
The Workbench can read and write Geography Markup Language files1.  However, when 
reading a GML file, the Workbench needs a special file called an input template that 
specifies the structure of the GML file. 
 
Note: If the GML file was created using JUMP GML, you don’t need to create an input 
template – see the instructions for JUMP GML below. 
 
If you do not have an input template for your GML file, you will have to create one.  Please 
refer to 12.1 Writing A GML Input Template on page 48. 
 

                                            
1 http://opengis.net/gml/01-029/GML2.html 
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Ñ To open a GML file 
• Create the input template (see 12.1 Writing A GML Input Template) 
• From the File menu, choose Load Dataset.  A dialog will appear. 
• From the Format combobox, choose GML 2.0 
• Select the GML file you want to open 
• Enter the pathname of the input template 
• Press OK 

 
Well-Known Text (WKT) is a simple format for specifying polygons, linestrings, and other 
geometrical shapes using simple text2.  But WKT does not store attributes.  The Workbench 
can open text files containing WKT geometries (they do not need to be separated by 
whitespace).  See 11 Appendix: Well-Known Text Syntax on page 46. 
 
Ñ To open a file containing Well-Known Text 

• From the File menu, choose Load Dataset.  A dialog will appear. 
• From the Format combobox, choose WKT 
• Select the file you want to open 
• Press OK 

 
The Shapefile spatial data format3 is published by ESRI. 
 
Ñ To open a Shapefile 

• From the File menu, choose Load Dataset.  A dialog will appear. 
• From the Format combobox, choose ESRI Shapefile 
• Select the file you want to open. (The associated .shx and .dbf files should be in the 

same directory). 
• Press OK 

 
Safe Software’s Feature Manipulation Engine (FME)4 is a popular software application for 
transforming spatial data.  The Workbench can read Geography Markup Language (GML) 
files5 generated by FME. 
 
Note: At the time of this writing, Safe Software has not finalized their FME GML format. 
Future GML files generated by FME may need to be read using an input template (see 
below). 
 
Ñ To open a GML file generated by FME 

• From the File menu, choose Load Dataset.  A dialog will appear. 
• From the Format combobox, choose FME GML 
• Select the file you want to open 
• Press OK 

 
The Layer List has a number of folders, or categories, that you can use to organize your 
layers.  For a discussion of the various categories, see 2.1 Workbench on page 8. 
 
Ñ To create a layer in a specific category 

• Right-click on the category and choose Load Dataset from the pop-up menu 
• Open a file as described above for the various file formats 

                                            
2 http://www.opengis.org/techno/specs.htm 
3 http://www.esri.com/software/opengis/openpdf.html 
4 http://www.safe.com/products/fme/index.htm 
5 http://opengis.net/gml/01-029/GML2.html 
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For information on copying a layer from one category to another, see 4.7 Copying A Layer 
on page 23. 
 

4.2 SAVING A LAYER 
You can save any layer in the Layer List to a file (even the vector layer – see 5.3 Drawing 
Vectors on page 26). 
 
Brief descriptions of each of the supported file formats are given in 4.1 Loading A Layer. 
 
Note: If you open a GML or FME GML file then save it again in the same format, some 
information may be lost.  The Workbench preserves only the information it uses: 
 

• one spatial attribute for each feature (the “geometry”) 
• some non-spatial attributes for each feature (strings, dates and numbers) 

 
Any information that the Workbench does not use will not be present in the document that 
gets saved.  Therefore, you should generally avoid using the Workbench to overwrite 
existing files, unless you are sure that you won’t need all of the information in the old file. 
 
Note: At the time of this writing, Safe Software has not finalized their FME GML format. In 
the future, GML files that you want to open using FME may need to be written using an 
output template (see below). 
 
Ñ To save a layer as a a JUMP GML file, a WKT file, a Shapefile, or a GML file that 

FME can open  
• Right-click on the name of the layer that you want to save and choose Save from 

the pop-up menu.  A dialog will appear. 
• From the Format combobox, choose JUMP GML, WKT, FME GML, or ESRI Shapefile 
• Enter the filename to save the layer as 
• Press OK 

 
Saving a layer as a general GML file is similar to opening a GML file in that the Workbench 
needs a special file called an output template that specifies the structure of the GML file. 
 
Note: You can also save a layer in a particular GML format: the JUMP GML format or FME 
GML format.  The Workbench doesn’t require you to use input and output templates for 
these formats – see the instructions above. 
 
If you do not have an output template for your GML file, you will have to create one.  Please 
refer to 12.2 Writing A GML Output Template on page 49. 
 
Ñ To save a GML file 

• Create the output template (see 12.2 Writing A GML Output Template) 
• Right-click on the name of the layer that you want to save and choose Save from 

the pop-up menu.  A dialog will appear. 
• From the Format combobox, choose GML 2.0 
• Enter the pathname to save the layer as 
• Enter the pathname of the output template 
• Press OK 
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4.3 CHANGING LAYER STYLES 
You can use the Styles dialog to customize: 
 

• rendering (e.g. colour and line width) 
• colour theming 
• labels (e.g. font and placement) 
• decorations (e.g. arrowheads) 

 
 

4.3.1 Rendering 
The first tab of the Styles dialog enables you to change general rendering properties, like 
colour and line width (see Figure 4-1 below). 
 
 

 
Figure 4-1 – The Styles dialog: Rendering tab 

 
 
Ñ To set a layer’s rendering properties 

• Right-click on the name of the layer and choose Change Styles from the pop-up 
menu 

• To change the fill and line colours, simply click one of the presets on the right. Or 
press the “…” buttons for more choices. If the Sync Line Colour With Fill Colour 
checkbox is selected, JUMP will pick a suitable line colour whenever you change the 
fill colour. 

• To prevent polygons from being filled in with colour, clear the Fill checkbox 

• To prevent linestrings and polygon boundaries from being drawn, clear the Line 
checkbox 

• To make linestrings and polygon boundaries wider, move the Line Width slider to 
the right 

• To display vertices with n symbols, select the checkbox beside Vertex Size 

• To make the vertex symbols larger, move the Vertex Size slider to the right 
• To make the layer more transparent, move the Transparency slider to the right 

• Press OK 
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4.3.2 Colour Theming 
The Colour Theming tab enables you to colour-theme a dataset by one of its attributes (see 
Figure 4-2 below).  
 
 

 
Figure 4-2 – The Styles dialog: Colour Theming tab 

 
 
Ñ To colour-theme a layer by the different values of one of its attributes 

• Right-click on the name of the layer and choose Change Styles from the pop-up 
menu 

• Click the Colour Theming tab to display the controls shown in Figure 4-2 above 
• Select the Enable Colour Theming checkbox 
• From the Attribute combobox, choose the attribute to colour-theme by 
• From the Colour Scheme combobox, choose one of the colour schemes. The 

number in parentheses indicates the number of colours in the scheme. 
• Press OK 

 
 

 
Figure 4-3 – The Styles dialog: Colour Theming tab, by range 

 
 
Ñ To colour-theme a layer by ranges of values of one of its attributes 

• Right-click on the name of the layer and choose Change Styles from the pop-up 
menu 

• Click the Colour Theming tab to display the controls  
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• Select the Enable Colour Theming checkbox 
• Select the By Range checkbox (see Figure 4-3 above) 
• From the Attribute combobox, choose the attribute to colour-theme by 
• From the Range Count combobox, choose the number of ranges (ideally not more 

than the number of colours in the colour scheme, indicated in parentheses) 
• From the Colour Scheme combobox, choose one of the colour schemes 
• To reverse the order of the colours in the colour scheme, press the Reverse Colours 

button 
• Press OK 

 
 

4.3.3 Labels 
The third tab of the Styles dialog allows you to set labelling options, like font and placement 
(see Figure 4-4 below). The preview at the bottom shows you what your changes will look 
like. 
 
 

 
Figure 4-4 – The Styles dialog: Labels tab 

 
 
Ñ To add labelling to a layer 

• Right-click on the name of the layer and choose Change Styles from the pop-up 
menu 

• Click the Labels tab to display the controls shown in Figure 4-4 above 
• Select the Enable Labelling checkbox 
• From the Label Attribute combobox, choose the attribute containing the text for the 

labels 
• From the Vertical Alignment combobox, choose whether you want labels to appear 

above, on, or below the line (this option applies to lines only, not points or 
polygons). “On the line” works well if the lines are thick. 

• If the layer has an attribute containing the angles for the labels, choose it from the 
Angle Attribute combobox. The values must be in degrees. 

• If the layer has an attribute containing the heights for the labels, choose it from the 
Angle Attribute combobox 

• Otherwise, enter a fixed height in the Height field 
• To have the labels grow/shrink as you zoom in/out, select Scale Labels With The 

Zoom Label 
• To skip drawing labels when they would overlap other labels, select Hide 

Overlapping Labels. This option produces a cleaner display. 
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• Press OK 
 
 

4.3.4 Decorations 
With the fourth tab of the Styles dialog, you can add decorations (like arrowheads) to your 
features (see Figure 4-5 below). 
 
 

 
Figure 4-5 – The Styles dialog: Decorations tab 

 
 
Ñ To add or remove layer decorations 

• Right-click on the name of the layer and choose Change Styles from the pop-up 
menu 

• Click the Decorations tab to display the controls shown in Figure 4-5 above 
• To add decorations to the layer, select them from the left list (hold down [Ctrl] to 

select more than one) and press “>” 
• Similarly, to remove decorations, select them from the right list and press “<” 
• Press OK 
 

 

4.4 EDITING A LAYER SCHEMA 
You can add, remove, and rename attributes using the Schema window. 
 
 

 
Figure 4-6 – The Schema window 
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Ñ To add an attribute to a layer 
• Make sure that the layer is editable (if necessary, you can right-click the schema 

table and choose Editable from the pop-up menu) 
• Type the name of the new attribute in a blank space in the Field Name column 
• Click in the Data Type column to choose from a list of data types (Integer, Double, 

String, Geometry). Note that a layer may have only one Geometry field. 
• Press Apply Changes to change the layer. Or to cancel your modifications, press 

Revert Changes. Note that applying your changes is not undoable. 
 
Ñ To delete an attribute from a layer 

• Select the attribute(s) to delete 
• Press the Delete button ( ) 

 
Ñ To change an attribute’s data type 

• Click in the Data Type column and choose a new data type for the attribute. 
• Press Apply Changes. 

 
Some data conversions are not permitted (e.g. converting the String “ABC” into an Integer; 
the String “123” can be converted, however). When a conversion error occurs, you will be 
notified and the data will not be changed. To ignore conversion errors, check the Force 
Invalid Conversions To Null checkbox – this option will simply null out data that cannot be 
converted. 
 
Ñ To change the order in which the attributes appear 

• Select one or more rows 
• Press the  (or ) button to move the rows up (or down) 
• To insert a row, select the row it should push down, then press . 

 

4.5 CREATING A BLANK LAYER 
You can create a layer from scratch, rather than load an existing one from a file. 
 
Ñ To create a new, empty layer 

• From the Layer menu, choose Add New Layer 
 
The new layer will be called “New”, and will be placed in the Working category (for more on 
categories, see 2.1 Workbench on page 8). To rename the layer, double-click on the name. 
 
You will now want to add features to your newly created layer.  See 6.3 Adding Features on 
page 34. For information on adding attribute columns to your layer, see 4.4 Editing A Layer 
Schema on page 21. For information on entering values into these attribute columns, see 
6.2 Editing Features on page 31. 
 
 

4.6 REMOVING A LAYER 
If you find that the list of layers is becoming too long, or cluttered with layers you no longer 
need, you can easily remove layers.  You will not be prompted to save them, so be sure to 
save any you’ll need later. 
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Ñ To remove layers from the layer list 
• Select the names of the layers that you want to remove (hold down [Ctrl] to select 

multiple layers). 
• Right-click on a selected layer name and choose Remove Selected Layers from the 

pop-up menu 
 
 

4.7 COPYING A LAYER 
You can copy layers from one category to another using the Clipboard. 
 
Ñ To copy layers to another category 

• Select the names of the layers to copy (hold down [Ctrl] or [Shift] to select more 
than one) 

• From the Layer menu, choose Copy Selected Layers 
• Right-click on the name of the category you wish to copy the layers to, and choose 

Paste Layers 
 
 

4.8 RENAMING A LAYER 
Renaming a layer is useful if you want to clarify the purpose of the layer, for example, when 
you are preparing a demo for other people. Note that layer names are temporary and will be 
lost when the Workbench is closed (unless you save the layers in a project file – see 3.5 
Saving A Task on page 14). 
 
Ñ To rename a layer 

• Double-click the layer name in the Layer List. 
• Edit the layer name. 
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5. SELECTION 

This section describes selection and the related concepts of fence and vector. 
 
 

5.1 SELECTING FEATURES 
Many Workbench actions require you to select features.  They include: 
 

• zooming to a specific feature (3.1 Zooming, page 11) 
• viewing the coordinates of a feature (6.1 Inspecting Features, page 28) 
• editing features (6.2 Editing Features, page 31) 

 
Ñ To select features by clicking on them 

• Ensure that the Select Tool ( ) is pressed 
• Click on the feature (hold down [Shift] to avoid clearing the existing selection).  

Selection handles will appear as shown in Figure 5-1 below. 
 
 

 
Figure 5-1 – Selection handles (yellow) 

 
 
Note: If you want to select features from the selected layers only, hold down [Ctrl]. 
 
By drawing a box, you can select several features at once. 
 
Ñ To select features by drawing a box 

• Ensure that  is pressed 
• Drag a selection box. (Hold down [Shift] to avoid clearing the existing selection) 

— or — 
• Ensure that the Fence Tool ( ) is pressed 
• Drag a box to create a fence 
• Right-click on the Layer View and choose Select Features In Fence from the pop-up 

menu 
 
Tip: Regardless of which tool is pressed, you can always select a feature using [Ctrl] + Left 
Click. For more shortcut keys, see 10 Appendix: Shortcut Keys on page 45. 
 
Another way to select features is to use the Attribute View.  The Attribute View is useful 
because you can sort the features by one of the attributes by clicking on its column header. 
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Ñ To select features if you know their attributes 
• Open an Attribute View (see 6.1 Inspecting Features on page 28) 
• Select one or more rows in the table 
• Press  (just to the left of the table).  The corresponding features will be selected 

in the Layer View. 
 
Ñ To select a part (i.e. element) of a GeometryCollection 

• If you do not see the Editing toolbox, choose Editing from the Edit menu. The 
Select Parts tool ( ) is in this window. 

• Ensure that the Select Parts tool is pressed.  
• Click on the part. Selection handles will appear. 

 
Note that MultiPoints, MultiLineStrings, and MultiPolygons are GeometryCollections, so the 
Select Parts tool works with them too. 
 
Ñ To select a hole 

• Ensure that the Select Linestrings tool ( ) is pressed. (This tool is in the Editing 
toolbox. If you do not see this window, choose Editing from the Edit menu). 

• Click on the edge of the hole (Hold down [Shift] to avoid clearing the existing 
selection) 

 
Now that you have a part or hole selected, you can perform a number of operations on 
them: 
 

• copy (6.5 Copying Features, page 36) 
• delete (6.4 Deleting Features, page 35) 
• zoom (3.1 Zooming, page 11) 
• insert vertex (6.2 Editing Features, page 31) 
• delete vertex (6.2 Editing Features, page 31) 
• move vertex (6.2 Editing Features, page 31) 

 
 

5.2 DRAWING A FENCE 
A fence is simply a temporary box that you draw on the Layer View.  Many Workbench 
actions require the use of a fence.  They include: 
 

• selecting the features in a fence (5.1 Selecting Features, page 24) 
• examining the vertices in a fence (6.1 Inspecting Features, page 28) 
• zooming to a fence (3.1 Zooming, page 11) 

 
Ñ To create a fence 

• Ensure that the Fence Tool ( ) is pressed 
• Drag a box to create a fence 

 
A new layer named Fence will be created in the System category.  This layer will not hold 
more than one feature – adding a feature to this layer will replace the existing feature. 
Otherwise, it is like any other layer: you can save it to a file, load it from a file, and use the 
drawing tools with it. 
 
Ñ To clear the fence 

• Right-click on the Fence layer in the Layer List 
• Choose Remove Selected Layers from the pop-up menu 
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Note: After loading the Fence layer from a file, it is important to set its name to “Fence”.  
The Workbench identifies the fence layer by this name. 
 
 

5.3 DRAWING VECTORS 
Vectors are line segments.  One end of the vector is called the tip; the other is called the 
tail.  An arrowhead is drawn at the tip. 
 
Some Workbench actions require the use of vectors.  They include: 
 

• applying an affine transform (Section 7.1, page 37) 
• applying a rubber-sheet warp (Section 8.2, page 42) 

 
Ñ To create a vector 

• Ensure that the Draw Warping Vector Tool ( ) is pressed. (This tool is in the 
Warping toolbox. If you do not see this window, choose Warping from the Tools / 
Warping menu). 

• Drag from one point to another point on the Layer View to create the vector 
• Repeat to create additional vectors (see Figure 5-2 below) 

 
 

 
Figure 5-2 – Three vectors 

 
 
Note that a new layer named Warping Vectors is created in the System category.  This layer 
is like any other layer – you can select vectors, delete vectors, and save vectors to a file. 
 
Ñ To delete a vector 

• Press the Delete Warping Vector Tool ( ) 
• Click on the vectors you’d like to delete. Or drag to create a box around the vectors 

to delete. 
 
Ñ To delete all vectors 

• If the Warping Vectors layer is not editable (i.e. the layer name is not bold red), 
make it editable by right-clicking its name and choosing Editable. 

• Right-click its name again and choose Delete All Features 
 
You can also retrieve vectors from a file as you would any other layer.  However, be sure 
that the file contains only two-point linestrings.  Similarly, do not add features to the vector 
layer other than two-point linestrings. 
 
Ñ To retrieve vectors from a file 

• Open the file as described in 4.1 Loading A Layer on page 15 
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• In the Layer List, double-click on the layer name to edit it 
• Rename the layer to “Warping Vectors” 

 
Note: It is important to name the layer “Warping Vectors”.  The Workbench identifies the 
vector layer by this name. 
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6. FEATURES 

A geographic feature is “an abstraction of a real world phenomenon … associated with a 
location relative to the Earth”6.  A feature has spatial attributes (polygons, points, etc.) and 
non-spatial attributes (strings, dates, and numbers). 
 
In the current Workbench model, each feature has one spatial attribute, or geometry, and 
zero or more non-spatial attributes. 
 
This section shows you how to: 
 

• inspect features 
• edit features 
• add features to a layer 
• delete features from a layer 
• copy features 

 
 

6.1 INSPECTING FEATURES 
There are a number of ways to examine the attributes of a feature. 
 

 
Figure 6-1 – The Attribute View 

 
Ñ To view a table of attributes for specific features 

• Ensure that the Info Tool ( ) is pressed (or hold down [Ctrl] and [Alt] to 
temporarily switch to this tool) 

• Click on a feature.  The Attribute View will appear (see Figure 6-1 above). 
• Or drag a box. The features in that box will have their attributes displayed. 
• Click on or drag around other features to see their attributes (hold down [Shift] to 

avoid clearing the table) 

— or — 
• Select one or more features (see 5.1 Selecting Features on page 24) 
• Right-click on the Layer View and choose Feature Info from the pop-up menu.  A 

window will appear. 
• Click the  tab to switch to the Attribute View 

— or — 
• Right-click on the name of the layer and choose View Attributes from the pop-up 

menu.  The Attribute View will appear, containing all the features in the layer. 
 

                                            
6 OGC Abstract Specification (http://www.opengis.org/techno/specs.htm) 
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Tip: If the layer is editable, you can edit the attributes directly. You can right-click the table 
and choose Editable from the pop-up menu. 
 
You can sort the table by one of the attributes by clicking on the column header for that 
attribute. In addition, you can control the parent Task Window (the graphical display of the 
features) using the controls to the immediate left of the table.  
 
Note: The “parent” Task Window is the Task Window that was on top when the Attribute 
View appeared. If the Attribute View’s buttons are all disabled, then the parent Task 
Window has been closed. 
 
Right-clicking on the table will pop up a menu of useful commands: 
 

• Editable – make the layer editable 
• Feature Info – open another Attribute View on the selected rows 
• View / Edit Schema – edit the table definition (see 4.4 Editing A Layer Schema on 

page 21) 
• Cut Selected Items – cut the selected rows (features) from the layer 
• Copy Selected Items – copy the selected rows from the layer 
• Delete Selected Items – delete the selected rows from the layer 

 
When you open a dataset, it is useful to look at each feature, one at a time.  This technique 
is also useful for demo’s. 
 
Ñ To zoom and pan to each feature in a layer, one at a time 

• Ensure that the Task Window and the Attribute View are both visible 
• Press the Zoom To Next Row button ( ) to show the first feature. 
• Keep pressing  to show subsequent features. 
• To go back to the previous feature, press . 

 
Ñ To use the Attribute View to select features on the Task Window 

• Ensure that the Task Window and the Attribute View are both visible 
• Select one or more rows in the Attribute View (hold down [Shift] or [Ctrl] to 

select multiple rows) 
• Press  to the left of the table to select the corresponding features on the Task 

Window. 
 
Other useful controls on the table’s toolbar are:  
 

• , which zooms to the selected rows’ features 

• , which zooms out until all features of all layers are visible 

• , which flashes the selected rows’ features on the Task Window. Useful for seeing 
where a row’s corresponding feature is located. 

 
An alternative to the Attribute View is the HTML View, which displays the vertices of each 
feature (see Figure 6-2 below). 
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Figure 6-2 – The HTML View 

 
Ñ To list the vertices of specific features 

• Ensure that the Info Tool ( ) is pressed 
• Click on a feature or drag a box around several features. An Attribute View will 

appear. 
• Click the  tab to switch to the HTML View 

— or — 
• Select one or more features (see 5.1 Selecting Features on page 24) 
• Right-click on the Layer View and choose Feature Info from the pop-up menu.  The 

HTML View will appear. 
 

You can modify the HTML View using the buttons to the left of it: 
 

• To see the Well-Known Text representation of the geometries, press WKT (11 
Appendix: Well-Known Text Syntax on page 46) 

• To see the Geography Markup Language representation of the geometries, press 
GML 

• To see simple coordinate lists, press CL 
• To see the features’ attributes, press  
• To see the geometries, make sure  is pressed 

 
Ñ To list the vertices that are within a specific area 

• Optionally, show the vertices of the layer (see 4.3 Changing Layer Styles on page 
18) 

• Ensure that the Fence Tool ( ) is pressed 
• Drag a box to create a fence around the vertices 
• Right-click on the Layer View and choose Vertices In Fence from the pop-up menu.  

The Vertices In Fence Window will appear (see Figure 6-3 below). 
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Figure 6-3 – Examining vertices inside a fence 

 
 
Ñ To make a rough measurement of a feature (or anything else on-screen) 

• Press the Measure Tool ( ) 
• Click on the Layer View where you want to begin measuring from. As you move the 

mouse around, the length of the measuring line appears on the status bar at the 
bottom. 

• Click on the Layer View to pin down the measuring line, or double-click to finish 
 
You can also display an on-screen scalebar to get an idea of the size of things. From the 
View menu, choose Scale Bar. The scalebar assumes that 1 unit = 1 meter. 
 
To obtain a more accurate measurement of a feature, see 7.3 Generating Feature Statistics 
on page 39. 
 
 

6.2 EDITING FEATURES 
Before a feature can be edited, its layer must be made editable. 
 
Ñ To make a layer editable 

• Right-click on the name of the layer and choose Editable from the pop-up menu. 
The layer name will turn red. 

 
A feature has a geometry and non-spatial attributes (e.g. strings, dates and numbers). The 
Workbench enables you to edit both geometries and non-spatial attributes. 
 
Ñ To move the vertex of a feature 

• Make sure that the layer is editable 
• Select the feature (see 5.1 Selecting Features on page 24) 
• Press the Move Vertex Tool ( ). (This tool is in the Editing toolbox. If you do not 

see this window, choose Editing from the Edit menu). 
• Drag one of the selection handles to a new location 

 
Ñ To add a vertex to a feature 

• Make sure that the layer is editable 
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• Select the feature 
• Press the Insert Vertex Tool ( ) in the Editing toolbox. 
• Click on a line segment at the point where the new vertex should be inserted 

 
Ñ To delete a vertex from a feature 

• Make sure that the layer is editable 
• Select the feature(s) 
• Press the Delete Vertex Tool ( ) in the Editing toolbox. 
• Click on the vertex that should be deleted. Or drag a box around several vertices to 

delete them. 
 
If you have two neighbouring features with vertices that are supposed to coincide but are 
slightly off, you can fix this problem using the Quick Snap Tool and the Snap Vertices Tool. 
The Quick Snap Tool is easier to use and will work for most cases. The Snap Vertices Tool 
provides more control (i.e. you can specify which vertex of which feature gets snapped to). 
 
Ñ To snap vertices together using the Quick Snap Tool 

• Make sure that the layer is editable 
• Press the Quick Snap Tool ( ). (This tool is in the Editing toolbox. If you do not see 

this window, choose Editing from the Edit menu). 
• If the two vertices are close together, simply click on them to snap them together. 

Otherwise, drag a box around them to snap them together. 
 
Ñ To snap two vertices together using the Snap Vertices Tool 

• Make sure that the layer is editable 
• Press the Snap Vertices Tool ( ) in the Editing toolbox. 
• Select the feature containing the vertex to snap to 
• Drag a box around the vertices to snap together 
• Hold down [Shift] and click the vertex to snap to. This step is necessary because 

the selected feature may have several vertices inside the box. 
 
Note that you can use these tools to: 

• snap vertices from several features together, not just two 
• snap vertices from features on several layers together, not just one 
• snap vertices on an editable layer to a vertex on an uneditable layer 
• snap a line segment to a vertex, or (using the Snap Vertices Tool) a vertex to a line 

segment. In both cases, a vertex will be inserted into the line segment. 
 
Options for the Quick Snap Tool and Snap Vertices Tool are described in 9 Options on page 
44. 
 
Ñ To move a feature 

• Make sure that the layer is editable 
• Select the feature(s) to move (see 5.1 Selecting Features on page 24) 
• Press the Move Selected Items Tool ( ). (This tool is in the Editing toolbox. If you 

do not see this window, choose Editing from the Edit menu). 
• Drag the feature(s) to a new location 

 
Ñ To move a hole 

• Make sure that the layer is editable 
• Press the Select Linestrings tool ( ) in the Editing toolbox. 
• Click on the edge of the hole to select it. 
• Press the Move Selected Items Tool ( ) 
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• Drag the hole to a new location 
 
Ñ To delete a hole 

• Make sure that the layer is editable 
• Press the Select Linestrings tool ( ).  
• Click on the edge of the hole to select it. 
• Press [Del] 

 
You can easily combine several features into a single GeometryCollection; conversely, you 
can explode a GeometryCollection into several features. 
 
Note: The combined feature will take its attributes from one of the original features. The 
other features’ attributes will be lost (although you can immediately press Undo to get them 
back). 
 
Ñ To combine several features into a GeometryCollection 

• Make sure that the layer is editable 
• Select the features 
• Right-click on the Layer View and choose Combine Selected Features from the pop-

up menu (if the menu is disabled, hover over it to get a tooltip explaining why) 
 
Ñ To explode a GeometryCollection into several features 

• Make sure that the layer is editable 
• Select the feature 
• Right-click on the Layer View and choose Explode Selected Feature from the pop-up 

menu 
 
A precise way to modify a feature’s geometry is to edit its Well-Known Text (WKT) – you 
can type in coordinates directly.  You can even change the geometry to something entirely 
different (for instance, a linestring to a polygon) by clearing the WKT and typing in 
something new.  See 11 Appendix: Well-Known Text Syntax on page 46. 
 
Ñ To edit a feature’s Well-Known Text 

• Make sure that the layer is editable 
• Select the feature 
• Right-click on the Layer View and choose Edit Selected Feature from the pop-up 

menu.  The Edit Feature Window will appear (see Figure 6-4 below). 
• Edit the WKT. The blue margin on the left indicates the coordinate number. 
• To beautify your WKT, press the Format button 
• Press OK 
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Figure 6-4 – Editing a feature’s Well-Known Text 

 
 
Ñ To edit a feature’s attributes 

• Make sure that the layer is editable 
• Use the Info Tool ( ) to open an Attribute View on the feature (see 6.1 Inspecting 

Features on page 28) 
• Double-click a cell in the table to begin editing it 

 
While editing a feature’s attributes, you can cancel editing the current attribute by pressing 
[Esc]. You can undo and redo completed edits using  and . 
 

6.3 ADDING FEATURES 
You can add feature to an existing layer or a blank layer (see 4.5 Creating A Blank Layer on 
page 22).  Snap-to-grid options are described in 9 Options on page 44. 
 
Ñ To draw a rectangle 

• Make sure that the layer is editable (see 6.2 Editing Features on page 31) 
• Ensure that the Draw Rectangle Tool is pressed ( ). (This tool is in the Editing 

toolbox. If you do not see this window, choose Editing from the Edit menu). 
• Drag a box to create the new feature 

 
For information on adding attribute columns to your layer, see 4.4 Editing A Layer Schema 
on page 21. For information on entering values into these attribute columns, see 6.2 Editing 
Features on page 31. 
 
Ñ To draw a polygon 

• Make sure that the layer is editable 
• Ensure that the Draw Polygon Tool is pressed ( ) 
• Click to place the first vertex (see Figure 6-5 below) 
• Keep placing vertices in this manner 
• Double-click to place the last vertex.  The Workbench will close the polygon for you 

and create the feature. 
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Figure 6-5 – Drawing a polygon 

 
 
Ñ To add a hole to a polygon 

• Make sure that the layer is editable 
• Select the polygon 
• Ensure that the Draw Polygon Tool is pressed ( ) 
• Draw the hole as you would a polygon (see above) 

 
Ñ To draw a linestring 

• Make sure that the layer is editable 
• Ensure that the Draw Linestring Tool is pressed ( ) 
• Click to place the first vertex 
• Keep placing vertices in this manner 
• Double-click to place the last vertex. 

 
A more precise way to create a feature’s geometry is to type in Well-Known Text (WKT).  
See 11 Appendix: Well-Known Text Syntax on page 46. 
 
Ñ To add a feature by specifying its Well-Known Text 

• Make sure that the layer is editable 
• Right-click on the name of the layer and choose Add New Features from the pop-up 

menu.  The Add Features dialog will appear (see Figure 6-6 below). 
• Enter the WKT.  (You can create several features at once here – just enter several 

WKT’s). 
• Press OK 

 
 

 
Figure 6-6 – Adding a feature by specifying its Well-Known Text 

 
 

6.4 DELETING FEATURES 
If some features have become obsolete, or if they have been accidentally added to a layer, 
you can easily delete them. If you then change your mind, you can undo the deletion (see 
2.2 Undo/Redo on page 9). 
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Ñ To delete specific features from a layer 
• Make sure that the layer is editable (see 6.2 Editing Features on page 31) 
• Select the features that you want to delete (see 5.1 Selecting Features on page 

24).  Check that no other features are selected. 
• Right-click on the Layer View and choose Delete Selected Features from the pop-up 

menu 
 
Tip: A quick way to delete the selected features is to press [Del]. The layers of each 
selected feature must be editable for this to work. 
 
Ñ To delete all features from a layer 

• Make sure that the layer is editable 
• Right-click on the name of the layer in the Layer List and choose Delete All Features 

from the pop-up menu 
 
Ñ To delete a hole 

• Make sure that the layer is editable 
• Press the Select Linestrings tool ( ).  
• Click on the edge of the hole to select it. 
• Press [Del] 

 
 

6.5 COPYING FEATURES 
You can copy features from one layer to another using the Clipboard facility. You can also 
copy entire layers from one category to another – see 4.7 Copying A Layer on page 23. 
 
Ñ To copy features to another layer 

• Select the features to copy (see 5.1 Selecting Features on page 24) 
• Right-click on the Layer View and choose Copy Selected Features from the pop-up 

menu 
• Right-click on the name of the layer you wish to copy the features to, and choose 

Paste Features 
 
There is also a Cut Selected Features menu item; to use it, you must ensure that the layer 
you are cutting from is editable (see 6.2 Editing Features on page 31). 
 
Note: You can actually copy and paste features to and from other applications, like 
Windows Notepad. The information that is transferred is Well Known Text (see 11 Appendix: 
Well-Known Text Syntax on page 46). 
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7. SPATIAL FUNCTIONS 

This section  describes advanced spatial functions for analyzing and modifying features: 
 

• validating a layer 
• computing an overlay 
• generating feature statistics 

 
 

7.1 VALIDATING A LAYER 
The Workbench has a facility for validating the topology of the features in a layer. 
 
 

 
Figure 7-1 – The validation dialog 

 
 
Ñ To apply a set of validations to a layer 

• Select the name of the layer 

• From the Tools menu, choose QA / Validate Selected Layers. The validation dialog 
will appear (see Figure 7-1 above). 

• Select the Check Basic Topology checkbox to check for the following errors: 
o a hole outside its shell 
o nested shells (i.e. a shell is inside another shell, but not inside a hole) 
o nested holes 
o a disconnected interior (e.g. when a hole touches its shell at two points) 
o self-intersection 
o duplicate rings 
o too few points in geometry component 

• To check that line segments are longer than a given amount, select the Check 
Minimum Segment Length checkbox and type in the minimum length 

• To check that angles between line segments are greater than a given amount, select 
the Check Minimum Angle checkbox and type in the minimum angle (in degrees) 

• To check that polygon areas are greater than a given amount, select the Check 
Minimum Polygon Area checkbox and type in the minimum area 

• To check that linestrings do not self-intersect, select the Check That LineStrings Are 
Simple checkbox 
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• To check that a layer contains only certain spatial data types, select the appropriate 
checkboxes on the right column.  Note that multi-points, multi-linestrings and multi-
polygons are kinds of geometry collections. 

• Press OK 
 
Two layers will be generated: 
 

• “Bad Features” contains copies of the features that had errors 
• “Error Locations” pinpoints the locations of errors as precisely as possible.  To use 

this layer, keep zooming in to an error location until the problem is visible. 
 
Note: If you keep zooming in, you may reach a point at which features appear to drift from 
their true locations, perhaps even disappearing from the Layer View altogether.  At this 
level of magnification, the resolution required is too great for the Workbench’s drawing 
system, and you should simply zoom out.  This limitation applies to extremely high 
magnifications only. 
 
Both of the generated layers contain descriptions of the errors – use the Attribute View to 
view the descriptions and step through each one (see 6.1 Inspecting Features on page 28). 
 
 

7.2 COMPUTING AN OVERLAY 
An overlay is the superimposing of one layer on another to analyze which features intersect 
and which do not.  The overlay function is also a useful means of clipping a layer using a 
rectangle or other polygon. 
 
The overlay function generates a layer containing the intersections of all pairs of input 
features (see Figure 7-2 below).  It is safe to use because the original layer is not modified; 
rather, a new layer is created. 
 
 

 
(a) 

 
(b) 

Figure 7-2 – (a) a layer and a rectangle that will be used to clip 
it (b) the clipped layer 

 
 
Ñ To clip a layer using a rectangle 

• Create a blank layer (see 4.5 Creating A Blank Layer on page 22) 
• Add a rectangle to the blank layer (see 6.3 Adding Features 34, and Figure 7-2a 

above) 
• Select the names of the rectangle layer and the layer you want to clip 
• From the Tools menu, choose Overlay.  The Overlay dialog will appear (see Figure 

7-3 below). 
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• To split multi-polygons and geometry collections, and to filter out non-polygons, 
select the Polygon Output checkbox 

• To copy attributes from features in the first layer to the generated layer, select the 
Transfer Attributes From First Layer checkbox 

• To copy attributes from features in the second layer to the generated layer, select 
the Transfer Attributes From Second Layer checkbox 

• Press OK 
 
 

 
Figure 7-3 – The Overlay dialog 

 
 
Instead of using a rectangle as the clipping region, you can also draw a general polygon, or 
even load a polygon from a file. 
 
Ñ To obtain the intersections between the features of two layers 

• Select the names of the two layers that you want to overlay 
• From the Tools menu, choose Overlay.  The Overlay dialog will appear. 
• Set the dialog options as described above 
• Press OK 

 
 

7.3 GENERATING FEATURE STATISTICS 
This section describes how to obtain basic statistics (e.g. area, length, number of vertices) 
for the features in a layer. 
 
Ñ To obtain statistics for each feature in a layer 

• Select the name of the layer to analyze 
• From the Tools menu, choose QA / Feature Statistics. A new layer will appear, 

named  “Statistics” 
• Right-click the Statistics layer and choose View Attributes from the pop-up menu. 

An Attribute View will be displayed, showing various metrics: number of vertices, 
number of holes, number of components (in geometry collections like multipoints), 
area, length, and type (see Figure 7-4 below). 
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Figure 7-4 – Feature statistics 

 
 
Ñ To obtain aggregate statistics for all the features in a layer 

• Select the name of the layer to analyze 
• From the Tools menu, choose QA / Layer Statistics.  The layer statistics will be 

displayed, as in Figure 7-5 below. 
 
 

 
Figure 7-5 – Layer statistics 
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8. WARPING 

A warp is an algorithm for modifying all of the features in a layer, usually according to 
some parameters that are easy to specify, such as vectors. This section describes how to 
warp a layer using various techniques. 
 

• applying an affine transform 
• applying a rubber-sheet warp 

 
 

8.1 APPLYING AN AFFINE TRANSFORM 
An affine transform is a linear transformation that is defined by the initial and final 
positions of three points.  The affine transform will translate, rotate, scale, flip, and shear 
the dataset so that the initial three locations are mapped to the final three locations. 
 
Affine transforms can be tricky to apply properly – sometimes you get results that you don’t 
expect!  However, they are safe to use because the original layer is not modified; rather, a 
new layer is created. 
 
 

 
(a) 

 
(b) (c) 

Figure 8-1 – Applying an affine transform, specifying (a) one 
point (b) two points (c) three points 

 
 
The simplest use of an affine transform is to move all the features of a layer.  This usage 
involves one vector.  The layer will not be rotated, scaled, flipped, or sheared – just 
translated (see Figure 8-1a above). 
 
Ñ To move all the features in a layer 

• Draw one vector (see 5.3 Drawing Vectors on page 26) 
• Select the name of the layer 
• From the Tools / Warp menu, choose Affine Transform 

 
When you supply two vectors, the layer will be translated, rotated, and scaled, but not 
flipped or sheared (see Figure 8-1b above). 
 
Ñ To specify a linear transformation using two points 

• Draw two vectors 
• Select the name of the layer 
• From the Tools / Warp menu, choose Affine Transform 
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When you supply three vectors, the layer will be translated, rotated, scaled, flipped, and 
sheared (see Figure 8-1c above). 
 
Ñ To specify a linear transformation using three points 

• Draw three vectors 
• Select the name of the layer 
• From the Tools / Warp menu, choose Affine Transform 

  
 

8.2 APPLYING A RUBBER-SHEET WARP 
A rubber-sheet warp (or more precisely a bilinear interpolated triangulation warp) is 
a simple technique for deforming a dataset using a set of control point pairs7.  Two 
triangulations are created: one using the source control points and one using the 
destination control points.  Each source-triangle-destination-triangle pair implicitly defines a 
linear transform that carries each point on the source triangle to the corresponding point on 
the destination triangle.  The dataset is transformed pointwise using the transform 
associated with the source triangle in which each data point falls (see Figure 8-2 below). 
 
 

 
(a)  

(b) 

 
(c) 

Figure 8-2 – Rubber-sheet warp:  (a) original dataset (b) 
warping vectors (c) warped dataset 

 
 
Warping is safe because the original layer is not modified; rather, a new layer is created. 
 
 

 
Figure 8-3 – The Warping toolbox 

 
 
Ñ To warp a layer 

• If the Warping toolbox is not visible, choose Warping from the Tools / Warping 
menu (see Figure 8-3 above). 

                                            
7 Marvin S.  White, Jr.  and Patricia Griffin.  Piecewise linear rubber-sheet map transformation.  The American 
Cartographer, 12(2):123-31, October 1985. 
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• Select the layer to warp in the Warping toolbox 
• Draw vectors representing the initial and final positions of the control points (see 

5.3 Drawing Vectors on page 26) 
• Press the Warp button 

 
If you are surprised by the results of a warp, you may want to display the triangulation used 
so you can see how the source points map to the destination points. 
 
Ñ To view the triangulation used by the warp 

• Select the Display Triangulation checkbox. Two layers will be generated, named 
“Initial Triangulation” and “Final Triangulation” 

 
It can be easier to warp a layer little by little, rather than defining all the warping vectors 
before pressing Warp. Or perhaps you’ve warped a layer, but you want to warp it some 
more — in effect, you want to warp the warped layer. You can do this using incremental 
warping. 
 
Ñ To warp a layer incrementally 

• Select the Warp Incrementally checkbox. The Warping Vector buttons will disable, 
and their corresponding Incremental Warping Vector buttons will enable. 

• Draw warping vectors as before. You’ll see that the layer will be warped 
immediately after you draw each vector. You can hit Undo at any time. 

 
You can switch midstream between incremental warping and non-incremental warping. 
 
If you want to start warping from scratch, simply press the Clear All Vectors button. 
 
If you have vectors stored in another layer and you want to copy them into the Warping 
Vectors layer, select the layer and press the Copy Layer To Vectors button. 
 
The Auto-Hide Layers checkbox will turn off the source layer when the Warp button is 
pushed. This checkbox will also turn off the layer containing non-incremental warping 
vectors during incremental warping. 
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9. OPTIONS 

This section describes the options available in the Options dialog (see Figure 9-1 below), 
which you can open by choosing Options from the Edit menu. 
 
 

 
Figure 9-1 – The Options dialog 

 
 
The options are described in Table 9-1 below. 
 
 

Table 9-1 – JUMP Options 

TAB OPTION DESCRIPTION 

Snap to vertices Whether the points you draw should snap to the vertices of nearby 
features 

Snap to vertices and 
lines 

Whether the points you draw should snap to the vertices and line 
segments of nearby features 

Snap to grid Whether the points you draw should snap to the intersections of the virtual 
grid 

Show grid Whether the virtual grid should be made visible 

Size The spacing of the virtual grid, in model units 

Show grid as points Whether only the intersections of the virtual grid should be drawn. These 
will be dots, and can be hard to see. 

Snap / Grid 

Show grid as lines Whether the gridlines should be drawn. Easier to see than the grid 
intersections. Recommended setting. 

Edit Prevent edits resulting 
in invalid geometries 

Whether to cancel draws, moves, vertex-deletions, and other editing 
transactions, if the resulting geometry is topologically invalid. 

Snap 
Vertices 
Tools 

Insert vertex if none in 
segment 

Whether line segments without a vertex in the range of the Quick Snap 
Tool (or Snap Vertices Tool) should participate in the snap by having a 
vertex inserted into themselves first. 
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10. APPENDIX: SHORTCUT KEYS 

Zoom in Alt + Left Click 
Zoom out Alt + Right Click 
Pan Shift + Alt + Drag 
Select feature Ctrl + Left Click 
Select feature from selected layers only Ctrl + Left Click (when Select tool is active) 
Add to selection / Deselect Shift + Ctrl + Left Click (also Shift + Left Click when Select tool is active) 
Delete selected features Del 
Feature Info Ctrl + Alt + Left Click 
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11. APPENDIX: WELL-KNOWN TEXT SYNTAX 

Well-Known Text is a simple, widely-accepted format for describing shapes using plain text. 
Here are three examples: 
 
 POINT (10 10) 
 LINESTRING (0 0, 100 0, 100 100) 
 POLYGON ((30 30, 40 30, 40 40, 30 40, 30 30)) 
 
The syntax for the Well-known Text representation of Geometry is defined below.   
 
The notation {}* denotes 0 or more repetitions of the tokens within the braces. 
 
<Geometry Tagged Text> := 
 <Point Tagged Text> 
 | <LineString Tagged Text> 
 | <Polygon Tagged Text> 
 | <MultiPoint Tagged Text> 
 | <MultiLineString Tagged Text> 
 | <MultiPolygon Tagged Text> 
 | <GeometryCollection Tagged Text> 
 
<Point Tagged Text> := 
 POINT <Point Text> 
 
<LineString Tagged Text> := 
 LINESTRING <LineString Text> 
 
<Polygon Tagged Text> := 
 POLYGON <Polygon Text> 
 
<MultiPoint Tagged Text> := 
 MULTIPOINT <Multipoint Text> 
 
<MultiLineString Tagged Text> := 
 MULTILINESTRING <MultiLineString Text> 
 
<MultiPolygon Tagged Text> := 
 MULTIPOLYGON <MultiPolygon Text> 
 
<GeometryCollection Tagged Text> := 
 GEOMETRYCOLLECTION <GeometryCollection Text> 
 
<Point Text> := EMPTY | ( <Point> ) 
 
<Point> := <x> <y> 
 
<x> := double precision literal 
 
<y> := double precision literal 
 
<LineString Text> := EMPTY 
 | ( <Point> {, <Point> }* ) 
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<Polygon Text> := EMPTY 
 | ( <LineString Text> {, <LineString Text> }*) 
 
<Multipoint Text> := EMPTY 
 | ( <Point > {, <Point > }* ) 
 
<MultiLineString Text> := EMPTY 
 | ( <LineString Text> {, <LineString Text> }* ) 
 
<MultiPolygon Text> := EMPTY 
 | ( <Polygon Text> {, <Polygon Text> }* ) 
 
<GeometryCollection Text> := EMPTY 
 | ( <Geometry Tagged Text> 
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12. APPENDIX: GML INPUT & OUTPUT TEMPLATES 

To read a general GML file, JUMP makes use of a mapping file called a GML input 
template.  This template specifies how the contents of the GML file are mapped to a JUMP 
features. Similarly, when saving a GML file, JUMP uses a GML output template to specify 
the structure of the output GML. The following sections explain how to create GML input and 
output templates. 
 
Note: You don’t need to create input or output templates for JUMP GML files. For more 
information, see 4.1 Loading A Layer and 4.2 Saving A Layer. 
 

12.1 WRITING A GML INPUT TEMPLATE 
GML Input Templates are able to extract a single FeatureCollection of features from a GML 
file.  Attribute values for each feature can be extracted from the GML describing the feature 
in a variety of ways. 
 
Listing 12-1 below shows an example of an input template (the column definitions are 
omitted and will be discussed later). 
 
 

<?xml version='1.0' encoding='UTF-8'?> 
<JCSGMLInputTemplate> 
    <CollectionElement>dataFeatures</CollectionElement>  
    <FeatureElement>Feature</FeatureElement> 
    <GeometryElement>gml:polygonProperty</GeometryElement> 
    <ColumnDefinitions> 
        ............. 
    </ColumnDefinitions> 
</JCSGMLInputTemplate> 

Listing 12-1 – Example of an input template (column definitions omitted) 

 
 
The input template begins by specifying the GML document’s collection element 
(dataFeatures) and the feature element (Feature). This information tells JUMP how to 
identify each feature in the GML document. 
 
Next, the geometry element and column definitions are given. These specify the spatial 
and non-spatial attributes of each feature. They specify child elements of the feature 
element (e.g. gml:polygonProperty is a child element of Feature). 
 
If there is more than one kind of geometry element in the file (e.g. Polygons and 
MultiPolygons), you can specify multiple GeometryElement tags. Note however that JUMP 
still assumes that each feature has only one geometry. If a feature is found to have more 
than one geometry, only the last one is read. 
 
Within the <ColumnDefinitions> tags are <column> tags, for each of the feature’s non-
spatial attributes. Listing 12-2 below shows an example of a column definition. 
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<column> 
    <name>Rainfall</name> 
    <type>DOUBLE</type> 
    <valueelement elementname="rainfall"/> 
    <valuelocation position="body”/>  
</column> 

Listing 12-2 – Example of a column definition 

 
 
name is the name that you want the column to have in JUMP.  
 
type may be STRING, INTEGER, DOUBLE, or DATE. (JUMP can identify and parse a variety 
of date formats, but the recommended format for your data is yyyy-mm-dd). 
 
value-element tells JUMP how to find the XML element containing the column value. In the 
example, the element is the one named “rainfall”.   In some cases there may be multiple 
elements with the same name in the GML for a feature.  To handle these cases, elements 
may be identified more precisely by providing a combination of the following attributes: 
 
Attribute Value Optional? 
element-name The name of the element N 
attribute-name The name of an attribute on the element Y 
attribute-value The value of the given attribute Y 
 
value-location tells JUMP how to extract the actual value of the column from the identified 
element. In the example the value is being extracted from the body of the element.  The 
template also supports specifying that the value is located as the value of an attribute of the 
element by using the attributeName attribute: 
 
 <value-location position=“attribute” attributeName=“average-rainfall”/> 
 
 

12.2 WRITING A GML OUTPUT TEMPLATE 
Output templates are literally a “template” for the text in the desired output file.  They 
consist of constant GML markup, together with symbols which will be replaced by the 
geometry and attribute information in a JUMP feature collection.   This allows complete 
flexibility in the GML produced.   (In fact, the output does not have to be GML at all, 
although the only Geometry output format currently supported is GML). 
 
GML output templates have the following structure: 
 

Header Section 
<%FEATURE%> 
Feature-Definition Section 
<%ENDFEATURE%> 
Footer Section 

Listing 12-3 – Output-template structure 

 
The header and footer sections can contain arbitrary GML markup or data.  They will appear 
at the beginning and end of the output GML file.  They contain the opening and closing 
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markup for the GML file elements as well as any elements which open and close the GML 
FeatureCollection. 
 
The Feature-Definition Section can contain arbitrary GML markup, as well special output 
template tags.   In the output GML the template tags will be replaced by the actual data for 
the geometry and attributes of a JUMP feature collection.  The Feature-Definition Section 
will be repeated once for each feature in the JUMP feature collection.  The supported output 
template tags are given below. 
 

Table 12-1 – Special output-template tags 

TAG DESCRIPTION 

<%=COLUMN columnname%> Inserts the value of the attribute named columnname. 

<%=GEOMETRY%> Inserts a GML representation of the geometry. 

 
 
An example of an output template is given in Listing 12-4 below. 
 

<?xml version='1.0' encoding='UTF-8'?> 
<dataset> 
<%FEATURE%> 
    <Feature> 
        <property name="FID"><%=COLUMN fid%></property> 
        <property name="DESCRIPTION"> 
            <%=COLUMN description%> 
        </property> 
        <GEOMETRY> 
            <%=GEOMETRY%> 
        </GEOMETRY > 
    </Feature> 
<%ENDFEATURE%> 
</dataset> 

Listing 12-4 – Example of an output template 

 
 
Note: If you open a GML or FME GML file then save it again in the same format, some 
information may be lost.  The Workbench preserves only the information it uses: 
 

• one spatial attribute for each feature (the “geometry”) 
• some non-spatial attributes for each feature (strings, dates and numbers) 

 
Any information that the Workbench does not use will not be present in the document that 
gets saved.  Therefore, you should generally avoid using the Workbench to overwrite 
existing files, unless you are sure that you won’t need all of the information in the old file. 
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13. APPENDIX: LICENCES FOR THIRD-PARTY LIBRARIES 

13.1 JAMA 
From http://math.nist.gov/javanumerics/jama/. 
 
This software is a cooperative product of The MathWorks and the National Institute of 
Standards and Technology (NIST) which has been released to the public domain.  Neither 
The MathWorks nor NIST assumes any responsibility whatsoever for its use by other parties, 
and makes no guarantees, expressed or implied, about its quality, reliability, or any other 
characteristic. 
 
 

13.2 ACME FMT 
From http://www.acme.com/java/software/Acme.Fmt.html. 
 
Fmt - some simple single-arg sprintf-like routines 
 
Transparency handling and variable bit size courtesy of Jack Palevich. 
 
Copyright (C)1996 by Jef Poskanzer <jef@acme.com>.  All rights reserved. 
 
Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 
 
1. Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, this list of 

conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution. 

 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS “AS IS'” AND ANY 
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
Visit the ACME Labs Java page for up-to-date versions of this and other fine Java utilities: 
http://www.acme.com/java/ 
 
 

13.3 SHAPEREADER 
From http://geotools.sourceforge.net/. 
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GNU Lesser General Public License 
 
 

13.4 JFONTCHOOSER 
From http://www.cruftworks.com/software/JFontChooser/. 
 
GNU Lesser General Public License 
 
 

13.5 COLORBREWER 
Colour schemes, from http://colorbrewer.org/ 
 
Permission to include colour schemes received from Cindy Brewer. Personal communication. 
 
 

13.6 VISUAL MINING, INC. 
Color schemes, from http://chartworks.com/resources/palettes.html. 
 
“Feel free to use these color palettes in your charts! Just copy the CDL ColorTable 
parameter below the swatch you like, and paste it into your CDL code. The definitions are 
arranged so that they will "wrap" pleasingly in charts; that is, the first & last values look 
good together.” 
 
 

13.7 TEXTURES (IBM TOKYO RESEARCH LABORATORY) 
From http://www-3.ibm.com/ibm/easy/eou_ext.nsf/Publish/629 (IBM Ease Of Use Website) 
 
THIS IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY) AND 
THE IBM CORPORATION. BEFORE DOWNLOADING OR USING THE CODE AND OR 
DOCUMENTATION (HEREINAFTER "MATERIAL"), YOU SHOULD CAREFULLY READ THE 
FOLLOWING TERMS AND CONDITIONS. DOWNLOADING OR USING THE MATERIAL 
INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT DOWNLOAD OR 
USE THE MATERIAL. THE MATERIAL IS OWNED BY IBM, ITS SUBSIDIARIES (IBM), OR 
IBM¹S SUPPLIERS, AND IS COPYRIGHTED AND LICENSED (ACCORDING TO THE TERMS 
AND CONDITIONS ENUMERATED BELOW), NOT SOLD. IBM RETAINS TITLE TO THE 
MATERIAL. 
 
 
I. GRANT OF LICENSES.  
 
Subject to the terms and conditions of this Agreement, IBM grants to you the non-exclusive, 
non-assignable, royalty free and fully paid-up license, under the applicable IBM copyrights, 
to:  
 
use, execute, display, perform, and reproduce, the Material;  
prepare derivative works based on the Material;  
distribute copies of the Material and derivative works thereof; and  
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authorize others to do all of the above, provided they agree to the terms and conditions of 
this Agreement.  
You may not copy, modify or merge copies of the Material except as provided in this 
Agreement. You may not rent, lease, sell, sublicense, assign, distribute or otherwise 
transfer the Material except as provided in this Agreement. You may not reverse compile or 
reverse assemble any part of the Material which is provided in object code form. 
 
You may not sell, transfer, assign, or subcontract any of your rights or obligations under 
this license. Any attempt to do so is void. 
 
You must reproduce the copyright notice and any other legend of ownership on each copy or 
partial copy of the Material and derivative works thereof. 
 
IBM would appreciate receiving a copy of derivative works of the Material that You create. 
You may provide to IBM such derivative works pursuant to the terms of this Agreement. You 
represent and warrant to IBM that You are the sole author of, and/or have full exclusive 
right, title and interest to any and all derivative works You provide to IBM. You further 
represent that You are under no obligation to assign your rights in such derivative works to 
any third party, including without limitation, any current or former employer. 
 
With respect to any derivative works of the Material You provide to IBM, You grant to IBM 
an irrevocable, worldwide, non-exclusive, perpetual, royalty-free and fully paid-up license 
to:  
 
use, execute, display, perform, and reproduce, the Material;  
prepare derivative works based on the Material;  
distribute copies of the Material and derivative works thereof; and  
authorize others to do all of the above.  
You agree that any information or feedback you may provide to IBM in reference to the 
Material or this Agreement is non-confidential and you grant IBM a worldwide, fully paid up 
and irrevocable license to use this information/feedback without restriction. 
 
 
 
II. DISCLAIMER OF WARRANTY. 
 
THE MATERIAL IS PROVIDED "AS-IS". IBM MAKES NO WARRANTIES OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, WITH RESPECT TO THE MATERIAL. IBM EXPRESSLY DISCLAIMS THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
AND ANY WARRANTY OF NON-INFRINGEMENT. THE ENTIRE RISK ARISING OUT OF USE OR 
PERFORMANCE OF THE MATERIAL REMAINS WITH YOU.  
 
Some jurisdictions do not allow the exclusion of implied warranties or the exclusion or 
limitations of consequential or incidental damages, so the above provisions relating thereto 
may not apply to you. 
 
IBM has no obligation to provide service, defect correction, or any maintenance for the 
Material. IBM has no obligation to supply any Material updates or enhancements to you 
even if such are or later become available. 
 
Under no circumstances is IBM liable for any of the following:  
 
third-party claims against you for losses or damages;  
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loss of, or damage to, your records or data; or  
direct damages, lost profits, lost savings, incidental, special, or indirect damages or other 
consequential damages, even if IBM or its authorized supplier, has been advised of the 
possibility of such damages.  
Neither of us may bring any legal action more than two years after the cause of action 
arose. 
 
Note to U.S. Government Users - Documentation related to Restricted Rights - use, 
duplication, or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract 
with IBM Corporation. 
 
This Agreement is entered into in the State of New York, U.S.A. and governed by the laws of 
the State of New York without regard to conflict of law principles. Regardless of where you 
access this Program from, you agree to comply with all applicable United States laws 
including those regarding export of data. 
 
 

13.8 IBM BITS&PCS ICON COLLECTION 
From http://www-3.ibm.com/ibm/easy/eou_ext.nsf/Publish/648. 
 
Licence from IBM Ease Of Use Website (see 13.7 Textures (IBM Tokyo Research Laboratory) 
on page 52). 
 
 

13.9 DEAN’S ICON COLLECTION 
From http://sourceforge.net/projects/icon-collection. 
 
This is a quick page to preview the icons I am creating for some of my Java(TM) programs.  
You are free to use them in your programs,   but I am retaining Copyright,   and they can 
not be used in any books, CD-ROM's, Web pages, or any other form of image collection 
without my consent.  I ask that if you do use them to drop me some e-mail at 
dean@gallant.com, also, if a screen shot of your application using these icons is available I 
will add a link to it from this page. I would please me greatly if you would add a little blurb 
in something like a ``Help about..'' screen like:  
 
Icons  Copyright(C) 1998  by  Dean S. Jones  
dean@gallant.com www.gallant.com/icons.htm  
 
The collection is somewhat small now,  but I will continue to add to it. Send me mail if you 
would like something added. I hope to create a library of standard icons for many 
applications to use,  I would like  for these icons to be the default icons for most Java(TM) 
freeware and  JFA Applications.  These icons  are all 20x20 pixels, and look best at high 
color and high resolutions.  The ``by hand'' anti-aliasing I did  looks best on a standard 
gray background.  I plan to produce a 16x16 subset.  I am working on some  Swing based 
icon management tools and an icon editor that can deal with alpha channels properly. The  
following image is a grid of the current icons. A web browser may dither the image 
somewhat, so there may be some artifacts. I look forward to your feedback.  
 
Dean S. Jones    
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